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Welcome 

Summary 

 Cytoscape v3.1 is now available for immediate download. 

 Relative to v3.0.2, it addresses 236 issues. 

 It is ready for use by all segments of the Cytoscape community. 

 It continues v3.0’s core feature set, specifically: 

o It contains improvements for all segments of the Cytoscape community. 

o It is upward compatible and can coexist with previous Cytoscape versions 

o The most popular plugins from previous versions are available, with more to 

follow. 

o Support offerings have been updated and broadened. 

 It includes 10 major feature updates 

 18 more Apps are available in the App Store as compared to the v3.0.2 release 

 What to do next … 

Dear Cytoscape User 
We are proud and pleased to release Cytoscape v3.1. This new release contains both new features and 

improvements to functionality and documentation, all of which are described in Section 11. 

Additionally, the App Store contains 28 more Apps than were available when v3.0.0 was released, 

bringing the total to 41. Since v3.0.2, 18 Apps were added, including: 

bayelviraApp eXamine MetDisease 
CoNet Gasoline MetScape 
CyKEGGParser GenomeSpace Pathway Scoring Application 
CyTargetLinker GIANT PEPPER 
CytoNCA HyperModules Reactome FI Plugin 
Enhanced Graphics KEGGScape WikiPathways 

 

If you are a new or casual Cytoscape user, welcome aboard! Feel free to either read on 

or jump ahead to What to Do Next for a quick start. 

For clarity, references to “Cytoscape 3.x” apply to all Cytoscape versions 3.0.0 and later. 

For Cytoscape v2.x Users 
Previous Cytoscape releases (through v2.8.3) focused on adding numerous annotation, import, layout, 

analysis, and visualization features, all of which have combined to deliver critical insights into biological 

processes of interest to Cytoscape’s broad and loyal user community. In fact, many of these features 

were created and contributed by Cytoscape users, themselves, using Cytoscape’s plugin architecture. 

Version 3.x marks a major reorganization of Cytoscape program code – it enables us to deliver additional 

features more quickly and reliably than before, including improvements that benefit new users, casual 

users, power users, and app developers. Along the way, some features were changed to allow them to 

better interoperate with other features, some little-used features were dropped, and user interface was 



improved. We are particularly excited about the new Cytoscape App Store (described below), which 

affords users access to the growing collection of apps (formerly called plugins) produced by fellow 

Cytoscape users. A table of new features is presented in Section 7. 

While version 3.x is upwardly compatible with previous Cytoscape versions (i.e., it can load, analyze, and 

display networks and attributes stored using previous versions, including v2.x), it can coexist with 

previous versions on the same workstation. It is not necessary to uninstall previous versions before 

installing version 3.x, and you can choose to use both on the same workstation. 

Version 3.x is still a work in progress and continues to evolve due to the outstanding efforts of its vibrant 

worldwide development community. Notably, while the Cytoscape team has ported the most popular 

plugins (as apps) from previous versions, porting less popular plugins was deferred so as to deliver 

version 3.x sooner and with features that support cutting edge investigation. A table of apps and their 

status is presented in Section 8. 

Finally, we recognize that with all new software (including version 3.x), there are growing pains. While 

we hope our users will learn to love v3.x’s new features, users may also expect to relearn rationalized 

features and occasionally uncover a bug. With version 3.x, we are rolling out new manuals, tutorials, 

web pages, and support channels that we hope can create and maintain highly productive experiences 

for all types of Cytoscape users. A table describing Cytoscape support is presented in Section 9. 

We are very excited to make this release, and hope you find it an indispensable tool in your research. To 

get you started, we have provided additional introductory material to get you started on the right foot, 

and we have also provided background material for general interest.  

Please let us know how we’re doing and how we can better advance your research! 

The Cytoscape Team 

  



What to Do Next 
We hope to help you use Cytoscape in the most productive way. Your next steps depend on how 

experienced you are with Cytoscape and what you would like to do. In the table below, please find the 

category that best describes you, and proceed accordingly. 

Type of Cytoscape User Where to Read Next 

New For New Users (Section 1) 

Casual For Casual Users (Section 2) 

Power For Power Users (Section 3) 

App Developers For App Developers (Section 4) 

General Interest Try getting oriented by reading: 
General Background (Section 5) 
Cytoscape App Store (Section 6) 

Then try browsing: 
New Features (Section 7) 
App Status (Section 8) 
Support Offering (Section 9) 
Future Plans (Section 10) 

To get your feet wet, try: 
For New Users (Section 1) 

  



1. For New Cytoscape Users 

What is Cytoscape? 

Cytoscape is software that can help you visualize complex networks (as graphs) representing 

relationships between genes, proteins, or other entities. Cytoscape tracks and displays these entities (as 

graph nodes) and relationships between them (as graph edges). Cytoscape, per se, does not assign 

meaning to either nodes or edges – you can assign your own meanings to them, and you can add your 

own node or edge attributes (e.g., name, measurements, states, etc.) that customize your graph to 

represent semantics important to you. While Cytoscape provides simple analytics and visualizations, 

others are available as apps from the Cytoscape App store (see Section 6). 

What Do I Need Before I Can Use Cytoscape? 

At the very least, you must provide Cytoscape with a list of nodes. You can also provide a list of edges 

and attributes. You can enter your graph manually or import it from your own files – Cytoscape supports 

a wide variety of file formats, including text and Excel. Cytoscape can also load pre-configured networks 

(e.g., from BioGRID) so you can leverage them without having to enter them yourself. 

Can Cytoscape Help Me Get Started? 

Yes! The Cytoscape team had provided many resources tailored for all kinds of users (see Section 9). To 

start, there is an Installation Guide and numerous tutorials. Once you load your graph, you may find 

additional useful analytics and visualizations at the App Store (see Section 6). 

Which Cytoscape Version Should I Use? 

Generally, you should use v3.1 (the newest version). v2.x has been in the field for several years and will 

be supported into the future, but over time, v3.x and successors will be better supported.  

Note that if you have already installed v3.0.0, v3.0.1, or v3.0.2, you can install v3.1 without 

uninstalling your previous version. 

How to Download and Install v3.x 

 Surf to http://www.cytoscape.org, click on the Download Cytoscape button, and follow the 

prompts 

 Be sure to consult with the Release Notes (viewable via the Release Notes button) for issues 

and solutions pertaining to your installation 

 Surf to http://www.cytoscape.org, click on the Release Notes button, click on a User Manual 

link, and follow the instructions in the Launching Cytoscape section. 

  

http://www.cytoscape.org/cy3.html
http://www.cytoscape.org/cy3.html


2. For Casual Cytoscape Users 
If you’re confident of your Cytoscape skills, please read the Power Users information (Section 3). 

If you’re Cytoscape skills are rusty, please continue with the New Users information (Section 1). 

  



3. For Cytoscape Power Users 

Is v3.x for Me? 

The answer is most likely yes, provided you use the apps (formerly known as plugins) available for v3.x – 

apps are available from the new Cytoscape App Store, which you can browse directly (Section 6). Note 

that some v2.x apps have been incorporated directly into Cytoscape and need not be downloaded or 

installed. Consult the Apps Status table (Section 8) to see a list of these apps. 

Note that v2.x plugins are not compatible with v3.x apps, and vice versa. If you rely on v2.x plugins that 

are not yet available for v3.x, you may need to remain with v2.x instead of upgrading to v3.x. Note, also, 

that the Cytoscape community is converting v2.x plugins to v3.x apps -- you might occasionally revisit the 

App Store to see if an app you need becomes available. 

What’s New in v3.x? 

As described in the Welcome letter (above), v3.x incorporates a number of new features (Section 7) and 

productivity enhancing support offerings (Section 9), including the Cytoscape App Store (Section 6). The 

General Background section (Section 5) describes the rationale, advantages, and issues with v3.x.  

Will Support for v2.x Continue? 

Cytoscape v2.x will be supported by the Cytoscape community for now, but with fewer upgrades and 

support options over time.  

Can I use v2.x and v3.x at the Same Time? 

You can experiment with v3.x by installing it on your workstation – you can use both v2.x and v3.x on 

the same workstation. 

How to Prepare for v3.x 

1. If you have already installed a v3.1 beta version, please uninstall it before proceeding. The 

Cytoscape v3.0.x versions can coexist with v3.1, and do not need to be uninstalled. 

2. Consult the Apps Status table (Section 8) to verify that the apps you need are available. Some 

apps have become part of the Cytoscape core, and you won’t need to download them. Other 

apps are available in the Cytoscape App store (described in Section 6). 

3. Browse the New Features table (Section 7) to see what we have added since v2.x. 

4. Browse the Future Plans table (Section 10) and Support Offering table (Section 9) to see where 

the Cytoscape community is going. 

How to Download and Install v3.x 

 Surf to http://www.cytoscape.org, click on the Download Cytoscape button, and follow the 

prompts 

 Be sure to consult with the Release Notes (viewable via the Release Notes button) for issues 

and solutions pertaining to your installation 

 Surf to http://www.cytoscape.org, click on the Release Notes button, click on a User Manual 

link, and follow the instructions in the Launching Cytoscape section. 

  

http://www.cytoscape.org/


4. For Cytoscape App Developers 
Cytoscape manages graph storage and display, and contains a number of common analytic and 

visualization functions. App Developers may write apps (formerly known as plugins) to perform 

problem-specific analytics, graph layouts, or other visualizations.  

Before starting app development, you should be familiar with overall Cytoscape usage and functionality 

– see the Power Users section (Section 3) to start working with v3.x if you have not already done so. 

Note that v2.x plugins do not work with v3.x. In order get the benefits of improved stability, the 

Cytoscape team found it necessary to change the relationship between plugins/apps and the Cytoscape 

core. Many plugins have been ported to v3.x (see Section 8). The porting exercise is substantial, and 

once a plugin is converted to an app, it will continue to work at least until v4.0 is released – there is no 

v4.0 planned at this time. For more on this topic, see: 

http://wiki.cytoscape.org/Cytoscape_3/CoreDevelopment/Motivation 

Should I Convert My v2.x Plugin to a v3.x App? 

Yes! Cytoscape v2.x will be supported by the Cytoscape community for now, but with fewer upgrades 

and support options over time. 

How Do I Get Started With App Development? 

To get started with app development: 

http://wiki.cytoscape.org/Cytoscape_3/AppDeveloper 

To convert a v2.0 plugin to a v3.x app, refer to: 

http://wiki.cytoscape.org/Cytoscape_3/AppDeveloper/PluginPortingGuide 

For a broader view of the Cytoscape system (including the Core), refer to: 

http://wiki.cytoscape.org/Cytoscape_3/CoreDevelopment 

Are there App Samples? 

Yes! See: 

http://opentutorials.cgl.ucsf.edu/index.php/Tutorial:Creating_a_Simple_Cytoscape_3_App 

Also note the App Cookbook: 

http://wiki.cytoscape.org/Cytoscape_3/AppDeveloper/Cytoscape_3_App_Cookbook 

 

  

http://wiki.cytoscape.org/Cytoscape_3/CoreDevelopment/Motivation
http://wiki.cytoscape.org/Cytoscape_3/AppDeveloper
http://wiki.cytoscape.org/Cytoscape_3/AppDeveloper/PluginPortingGuide
http://wiki.cytoscape.org/Cytoscape_3/CoreDevelopment
http://opentutorials.cgl.ucsf.edu/index.php/Tutorial:Creating_a_Simple_Cytoscape_3_App
http://wiki.cytoscape.org/Cytoscape_3/AppDeveloper/Cytoscape_3_App_Cookbook


5. General Background 
The overall mission of Cytoscape is to be a freely available worldwide asset supporting network analysis 

and visualization for systems biology science. 

The major focus of v3.x is the modularization and rationalization of code to solve stability issues in v2.x 

encountered as multiple developers pursued multiple agendas. Under v2.x, internal programmatic 

interfaces evolved from one release to the next, leading to the failure of working plugins over time and 

negative interactions between otherwise working plugins. Ultimately, this resulted in loss of 

programmer and user productivity, and undermined community confidence in Cytoscape. 

v3.x addresses these issues by adopting modular coding practices promoted by the OSGi architectural 

framework1. This enables both the Cytoscape core and externally developed apps (formerly called 

plugins) to evolve independently without compromising unrelated functionality. At the logical level, 

Cytoscape leverages OSGi precepts to produce v3.x APIs having cleaner and clearer demarcations 

between functional areas. At the deployment level, OSGi enables on-the-fly substitution of one 

processing element for another (e.g., apps) in order to tailor Cytoscape to meet user requirements at 

runtime without reinstalling or reconfiguring Cytoscape. 

Creating v3.x occupied an international team of engineers for over a year, and represents a strong 

investment toward reducing future development and support costs, and increasing reliability and 

evolvability. With the completion of v3.x, we expect to leverage v3.x as a platform to satisfy the evolving 

needs of multiple stakeholder groups, and as a platform enabling research on leading edge analysis and 

visualization techniques. v3.x is the intended successor to v2.x, with development and support of v2.x 

expected to diminish and disappear over time in favor of v3.x.  

We believe that users will benefit most directly from the v3.x by: 

 experiencing fewer core and app bugs from one release to the next 

 the availability of more and richer apps (due to developers spending less time tracking and fixing 

bugs) 

 more core features with higher biological and logistical value (due to improved flexibility 

provided by interface-driven development) 

During the creation of v3.x, a number of features were added, as listed in the New Feature Table below. 

As a result, we incurred a number of current and future costs: 

Cost Reason Time frame for addressing 

Slower startup time OSGi module inventorying near-to-medium term 

Loss of plugins Lag in upgrading less popular 
plugins 

as needed 

  

                                                             
1 www.osgi.org – also used as the basic framework for Eclipse and numerous commercial products 

http://www.osgi.org/


6. The Cytoscape App Store 
The Cytoscape App Store is new in v3.x and targets broad demographics through specific features: 

Cytoscape User Benefit 

New or Casual Find Cytoscape functionality easier via familiar 
paradigms of search and tag navigation 

Power or Frequent  Find and install apps easier and provide 
crowdsourced rating and reviews 

Plugin Developers Have a dedicated presence for their work, including a 
direct line to their users and critical statistics to 
justify their development on the Cytoscape platform.  

Furthermore, the App Store supports contests and social incentives that encourage critical technical and 

community development, including porting, analytics, rating/reviewing, and so on.  

Note that the App Store supports only Cytoscape v3.x and does not contain plugins compatible with 

earlier Cytoscape versions. Likewise, plugins that work with earlier versions are not compatible with v3.x 

– Section 8 contains a list of apps available for v3.x. 

To access the App Store, access Cytoscape’s new Apps menu and choose the App Manager menu item, 

or use your browser to surf directly: 

http://apps.cytoscape.org 

  

http://apps.cytoscape.org/


7. New Feature Table 
Feature Beneficiary Manual Section 

Welcome screen New users (for solicitousness), casual 
and power users (for convenience) 

5.1. Welcome Screen 

New Style replaces 
VizMapper 

All users  14. Styles 

Export to cytoscape.js Power users wanting to present 
networks on web pages 

23. Cytoscape.js and 
Cytoscape 

Merge columns Users of attributes in multiple tables 17.2. Merging Tables 

Command line interface Power users creating repeatable 
workflows 

24. Scripting 

REST interface Power users using other applications 
to communicate with Cytoscape  

 

New filter facility All users  12. Finding and Filtering 
Nodes and Edges 

Group annotations Users with highly annotated networks  

Automatic citations Users publishing Cytoscape analyses 5.3.8 Help 

Improved PSICQUIC 
access 

All users needing to download 
protein databases 

 



  

8. App Status Table 
For the most up to date list of apps, see the App Store (described in Section 6). A URL for our 

development list is shown below, as a list of apps and their status at the time this letter was authored. 

https://docs.google.com/spreadsheet/ccc?key=0ArzUWDuvdBn-

dDI0R0kwOERjN1ZhcDZseC00dVZNNlE&authkey=CMGe99EM#gid=0 

Apps new since the v3.0.2 release are highlighted in yellow. 

App Capability Status 

addParentNeighbors For a selected node in child network, adds 
neighboring nodes from a parent network . 

 

AdvancednetworkMerge Merges multiple networks.  

AgilentLiteratureSearch Mines scientific literatures to find ones 
related to search term and to create 
interaction network based on the search 
result. 

Available in App 
Store 

AllegroMCODE Very fast clustering based on MCODE 
algorithm. 

 

APCluster Uses affinity propagation described in Frey 
BJ and Duec D (2007) to perform clustering. 

 

APID2NET Downloads PPI data from 
http://bioinfow.dep.usal.es/apid/ and 
performs various analyses including protein 
motif, GO, hub identification, etc. through 
the original GUI. Equipped with impressing 
"rainbow" coloring of nodes. 

 

BiLayout Finds a bipartite network for two sets of 
user-selected nodes and performs layout. 

 

BiNGO Calculates overrepresented GO terms in 
the network and display them as a network 
of significant GO terms. 

Available in App 
Store 

bioCycPlugin Loads any pathway in bioCyc database. 
Original panel provides useful information 
for each node. 

In Progress 

BiogridPlugin Loads Biogrid tab file onto Cytoscape.  

BiomartClient Retrieves attributes associated with given 
gene or protein 

 

BioNetBuilder Through the wizard, user can easily 
construct networks from public databases. 
User can also create interologs. 

 

BioQualiPlugin Performs consistency check of regulatory 
network and expression data. 

 

Bisogenet Retrieves interactions associated with input 
IDs. Sophisticated UI gives links to GO, 
KEGG, etc. 

 

BLAST2similarityGraph Visualizes BLAST similarity as graph.  

https://docs.google.com/spreadsheet/ccc?key=0ArzUWDuvdBn-dDI0R0kwOERjN1ZhcDZseC00dVZNNlE&authkey=CMGe99EM#gid=0
https://docs.google.com/spreadsheet/ccc?key=0ArzUWDuvdBn-dDI0R0kwOERjN1ZhcDZseC00dVZNNlE&authkey=CMGe99EM#gid=0


bayelviraApp Builds Bayesian networks using a file of 
patterns as input data using Naive Bayes, 
Semi Naive Bayes, Selective Naive Bayes, 
TAN, KDB and Class Tree Naïve algorithms. 

Available in App 
Store 

CABIN Integrates interaction datasets from 
different resources to explore the 
integrated network and to perform 
confidence analysis for interactions. User 
can give weight to each interaction set 
which will be used for the level of 
confidence. 

 

CalculatenodeDegree Simply calculates degree for selected single 
node. 

 

CentiScaPe Calculates topological characteristic values 
(ex. Centralities) for each node. 

Available in App 
Store  

ChemViz Visualizes chemical structure of each 
compound in chemical network with 
original interface. 

 

ClojureEngine Provides Clojure API.  

ClueGO Creates and visualizes a functionally 
organized GO term network or pathway 
from given interaction network. 

Available in App 
Store 

CluePedia Pathway insights using integrated 
experimental and in silico data 

Available in App 
Store 

clusterExplorerPlugin Explores a given similarity graph.  

clusterMaker Clusters densely connected nodes and node 
attributes (i.e. expression data)  in a given 
network. Results of these two types of 
clustering can be analysed in the integrated 
interface. 

In Progress 

ClusterONE Finds overlapping protein complexes in a 
protein interaction network. Clusters are 
visualized by original interface with their p-
values. 

Available in App 
Store 

ClusterViz Clustering based on FAG-EC, EAGLE or 
MCODE. Found cluster can be subjected to 
GO enrichment analysis. 

Available in App 
Store 

commandTool Provides simple command-line interface to 
Cytoscape. 

 

CommFinder Clustering based on QCUT, HQCUT, MCL, 
MCODE. 

 

Commonattributes Find attributes shared between selected 
nodes. 

 

CoNet Clustering based on FAG-EC, EAGLE or 

MCODE. Found cluster can be subjected to 

GO enrichment analysis. 

Available in App 
Store 

ConsensusPathDBplugin Retrieves interaction evidences for given 
pair of genes or proteins 

 



Cy3 Performance Reporter Collects information about Cytoscape 3 
performance 

Available in App 
Store 

CyAnimator Creates animation based on added frames 
of network views. 

 

CyClus3D Clusters a given network based on three-
node motifs. Accepts multiple types of 
interactions. Cluster ID is given to edge 
attributes, "EdgeCluster". 

 

CyGoose Provides Gaggle Boss, which routes data 
from one application to another. 

 

CyKEGGParser Parses and increases accuracy and 
specificity of KEGG pathways. 

Available in App 
Store 

Cyni Toolbox Network Inference Toolbox for inferences 
from bio-data. 

Available in App 
Store 

CyOog   

CyPath2 GUI client app for Pathway Commons 2 
(BioPAX L3 pathway data) web service. 

Available in App 
Store 

CyTargetLinker Extends biological networks with 
regulatory interactions. 

Available in App 
Store 

CyThesaurus-ID-Mapping Performs ID mapping using BridgeDb and 
other public or custom database sources. 

 

CytoCluster Analyze and visualize clusters from 
network. 

Available in App 
Store 

cytoHubba Predicts and explores important nodes and 
subnetworks in a given network by several 
topological algorithms. 

 

CytoKegg Identify Kegg pathways associated to 
specific expression profiles. 

Available in App 
Store 

CytoNCA Providing calculation, evaluation and 

visualization analysis for several 

centralities of weighted and unweighted 

network. 

Available in App 
Store 

Cytoprophet   

CytoSaddleSum Finds enriched function based on sum-of-
weight scores. 

 

CytoscapeRPC Allows user to query and modify networks 
through an XML-RPC connection. 

 

CytoSEED Enables users to view, manipulate and 
analyze metabolic models created by the 
Model SEED. The reactions are organized 
into a set of maps based on each reaction's 
membership in KEGG pathways. 

 

CytoSQL Retrieves attributes from SQL databases by 
invoking query command. 

 

DisGeNET Queries and analyzes networks of diseases 
and their associated genes. 

 

DomainGraph Visualizes domain-domain interactions 
which connect pairs of interacting proteins. 

 



DroID Retrieves interactions associated with input 
IDs. Detailed information associated with 
interactiong proteins can also be obtained. 

 

dynamicXpr Dynamically change colors of nodes like a 
movie according to their expression level 
across many conditions. 

 

DynNetwork Visualize dynamic networks. Available in App 
Store 

edgeLengthPlugin Calculate edge length in the main network 
view window, and stores them as edge 
attributes "length". 

 

edgeLister Records selected edges and provides some 
functionality for them (ex. hiding recorded 
edges) 

 

Enhanced Graphics Passthrough mapper for charts and 
gradients. 

Available in App 
Store 

EnhancedSearch Performs keyword search. Wildcards, 
logical operators, etc. are allowed. 

Available as part 
of core 

EnrichmentMap Visualizes enrichment of specific functions 
(GO terms) by interactions between 
functions. 

 

eXamine Set-oriented visual analysis approach for 
annotated modules that displays set 
membership as contours on top of a node-
link layout. 

Available in App 
Store 

ExprEssence Searches for differentially altered links in a 
given network using multiple set of 
expression data. 

 

ExpressionCorrelation Makes a similarity network where nodes are 
genes, and edges denote highly correlated 
genes. 

 

FERN Performs stochastic simulation of chemical 
reaction networks. 

 

FluxViz Visualizes fluxes as visual effect to edges on 
Cytoscape network. 

 

FM3 Performs one of the fastest multilevel force 
directed Layouts called FM3 Layout 
introduced by Hachul S et al 2005. 

 

FunNetViz Integrates and visualizes co-expression 
network with biological role of transcripts 
(e.g., GO terms). Centrality measures are 
equipped. 

 

Gasoline Multiple local alignment of protein-protein 
interaction (PPI) networks. 

Available in App 
Store 

GeneMANIA Generates interaction networks from 
public databases based on user's list of 
genes. Also provides annotation and 
putative function for those genes. 

Available in App 
Store 

GenomeSpace Enables communication with 
GenomeSpace 

Available in App 
Store 



Genoscape   

GFD-Net Analyze a gene network based on Gene 
Ontology (GO) and calculate a quantitative 
measure of its functional dissimilarity. 

Available in App 
Store 

GIANT Network analysis according to the 
Guimerà-Amaral cartography 

Available in App 
Store 

GoogleChartFunctions Creates image from attribute values (URL) 
using the Google Chart API. 

 

GPML-Plugin Enables import of GPML file via import 
menu. 

 

GraphletCounter Calculates "graphlet" (small connected non-
isomorphic subgraph) degree distribution. 

 

GraphMLReader Loads interactions or pathways in GraphML 
format. 

Available as part 
of core 

GroovyEngine Provides scripting interface of Groovy.  

GroovyScriptingEngine Provides scripting interface of Groovy.  

GroupTool Enables user to defines groups of nodes. For 
each group, basic information such as 
number of nodes will be displayed on the 
panel. 

In Progress 

HiderSlider Provides user sliders which can hide nodes 
whose continuous attribute is below 
threshold specied by sliders. 

 

HyperEdgeEditor Enables one to create hyper-edge by 
Cytoscape editor. 

 

HyperModules Uses local graph search heuristics to detect 
closely connected gene network regions in 
which gene mutations correlate with 
clinical features. 

Available in App 
Store 

IgraphPlugin Brings some functionality of Igraph such as 
layouts into Cytoscape. Mac only. 

 

IntActWSClient Retrieves interactions associated with 
input IDs. 

Replaced by 
PSICQUIC 

Interference Evaluates the topological effects of single or 
multiple nodes removal from a network 
using the effect to Radiality, Closeness, 
Betweenness, Centroid Value and 
Eccentricity. 

In Progress 

iRefScape Retrieves interactions associated with input 
IDs. Detailed information for each 
interaction as well as link to iRefIndex is 
provided.  

 

jActiveModules Finds clusters where member nodes show 
significant changes in expression levels. 

Available in App 
Store 

JavaScriptEngine Provides Java Script API. Available as part 
of core 

JEPETTO Performs biological gene sets enrichment 
analysis based on interaction network and 
topological properties. 

Available in App 
Store 



KEGGscape  Available in App 
Store 

KeyPathwayMiner Detects highly-connected sub-networks 
where most genes show similar expression 
behavior. 

Available in App 
Store 

KGMLReader Enables import of KEGG XML file via import 
menu. 

 

mcl-new Clusters given network. Subnetwork is 
indicated by set of nodes, and they are 
shown by selecting subnetwork number. 

 

MCODE Clusters a given network based on vertex 
weighting by local neighborhood density 
and outward traversal from a locally dense 
seed protein to isolate the dense regions. 

Available in App 
Store 

MetaNetter Infers of metabolic networks based on high 
resolution metabolomic data. 

 

MetanodePlugin2 Enables user to define "meta-node", a 
group of nodes. Meta-nodes can have 
hierarchy. 

Available as part 
of core 

MetDisease Annotates metabolic networks with MeSH 
disease terms and links to references. 

Available in App 
Store 

MetScape Loads human or mouse metabolic network. 
Sophisticated GUI is provided which allows 
user to perform various tasks including 
gene expression analysis along the 
pathways. 

Available in App 
Store 

MiMIplugin Retrieves interactions associated with input 
IDs. User can add own annotations to genes 
which can be viewed by different users. 

In progress 

MINE Clusters a given network based on 
agglomerative clustering algorithm very 
similar to MCODE, but it uses a modified 
vertex weighting strategy and can factor in a 
measure of network modularity. 
Adjustment of only few parameters are 
necessary. 

 

MiSink Provides network interface to MiSink-
enabled Web sites, including DIP. 

 

MONET Predicts gene regulatory network from 
biological annotations and expression data. 

 

Mosaic Systematically partition the given graph, 
and layout and color nodes based on GO 
terms. 

 

NamedSelection Assign name to selected nodes, and after 
unselection, enables user to re-select the 
nodes according to the name. 

 

NCBIClient Imports various data from NCBI database.  

NCBIEntrezgeneUserInterface Imports various data from NCBI database. Available as part 
of core 



NeighborHighlight Highlights the current node and all its 
neighboring nodes and edges when the user 
hovers the mouse over it. 

 

NeMo Identifies densely connected and biopartite 
network modules based on combination of 
a unique neighbour-sharing score with 
hierarchical agglomerative clustering. 

 

NetAtlas Integrates gene expression data of multiple 
tissues (ex. from Symatlas) into pre-loaded 
network. genes showing characteristic 
expression in specified tissues can be 
filtered and colored. 

 

NetCirChro Visualizes interaction network on circular 
genome. Original GUI with some network 
analysis functions (shortest path, degree 
distribution, etc.) are equipped. 

 

NetMatch Finds user defined network motifs in a given 
network. network motif can be created and 
edited using original GUI. 

 

NetworkAnalyzer Computes basic properties of whole 
network (degree distribution, clustering 
coefficients, centrality, etc.) 

Available as part 
of core 

NetworkEvolution Allows interactive comparative analysis of 
networks across different species. 

 

nodeCharts Paints bar, line or pie graphs onto nodes.  

OmicsAnalyzer Integrates omics data such as expression 
data, proteome data, etc. onto the network 
to visualize such data by graph on the 
network. 

 

OrthoNets Enables simultaneous comparison of 
interaction network of two species. Protein 
domain information can be visualized. 

 

PathExplorer Finds paths, filters them based on node 
and edge attributes and saves them. 

Available in App 
Store 

PanGIA Performs integrated analysis and 
visualization of PPIs and genetic interactions 
to infer functional modules and interactions 
that connect these modules. 

 

Pathintegrator Integrates pathways in which given proteins 
are associated. 

 

Pathway Scoring Application Evaluates the biological activity of genes 
and processes in pathways 

Available in App 
Store 

PEPPER Find meaningful pathways / complexes 
connecting a protein set members within a 
PPI-network using multi-objective 
optimization. 

Available in App 
Store 

PerturbationAnalyzer Evaluates how perturbation of selected 
nodes affect other nodes in a given network 
based on level of each node (ex. protein 
abundances) and law of mass action.  

 



PhosphositePlus Web Service 
Client Module 

Integrates phosphorylation-related 
information into the network. 

 

PhyloTree Reads a file in phylogenetic tree format 
(Phylip or phyloXML) and visualizes it as a 
network. 

 

PICRClient   

PINA4MS A visualization and analysis tool to study 
interactions between multiple sets of 
proteins. 

Available in App 
Store 

PiNGO Finds candidate genes in a network that are 
associated with user-defined target GO 
terms. 

 

PinnacleZ Searches for subnetworks which can 
discriminate givein conditions according to 
PPI network and gene expression data 
obtained in given conditions 

 

PSICQUICUniversalClient Retrieves interactions associated with 
input IDs from databases having PSICQUIC 
implementation 

Available as part 
of core 

PythonScriptingEngine Provides Python API.  

Randomnetworks Generates random network or randomizes 
already loaded network. 

 

RDFScsape Allows to query, visualize and reason on 
ontologies represented in OWL or RDF 
within Cytoscape. 

 

Reactome FI Plugin Accesses to Reactome Functional 
interaction (FI) network to perform 
pathway analyses such as identification of 
pathways enriched with proteins in given 
network. 

Available in App 
Store 

ReConn Communicates with reactome server to load 
pathway data onto Cytoscape. Additional 
features such as integration of expression 
data are supported. 

 

RemainingDegreeDistribution Calculates remaining degree (excess degree) 
distribution. 

 

ReOrientPlugin Layouts node positions according to 
reference Cytoscape session file. 

 

RubyScriptingEngine Provides Ruby Script API.  

ScriptEngineManager Manages scripting engines for Cytoscape. 
Supports Ruby, JavaScript, Groovy, and 
Python. 

Available as part 
of core 

SemScape Visualizes Semantic Data Landscapes Available in App 
Store 

SessionForWeb Saves Cytoscape session in Web format.  

SFLDLoader Represents structural protein families and 
their homologs by graph on Cytoscape. 

 

ShortestPath Finds shortest pathway between two 
selected nodes. 

 



SimTrek Assesses similarity of gene ontologies for 
given genes and their neighbours. All files 
must be installed in plugin folder. 

 

StringWSClient Retrieves interactions associated with input 
protein name. 

 

structureViz Enables user to traverse from biological 
networks to detailed view of their 
structures. 

In Progress 

Superpathways-Plugin Downloads and integrates multiple 
pathways from Wikipathways. 

 

TransClust Clusters a given similarity graph.  

Venn and Euler Diagrams Provides a diagram view and a details view 
for comparing two or more Cytoscape 
groups at a time. 

Available in App 
Store 

VistaClaraPlugin Provides effective visualization and 
analysis platform to analyse expression 
data on a given network. 

 

WikiPathways WikiPathways web service client and GPML 
file format importer. 

Available in App 
Store 

WordCloud Summarizes functions of interacting clusters 
as logos, where sizes of logo represents 
frequencies of these functions. 

 

  



9. Support Offering Table 
 Feature Purpose Beneficiary URL 

 Cytoscape Google 
Groups 
 Helpdesk 
 Discuss 

Community 
response on best 
effort basis 

All users mailto:cytoscape-
helpdesk@googlegroups.com 
mailto:cytoscape-discuss 
@googlegroups.com 

 User Manual Comprehensive 
manual 

All users http://wiki.cytoscape.org/Cytoscape_3
/UserManual 

 Installation Guide Cytoscape 
installation 

New/Casual 
users 

Section 3 of 
http://wiki.cytoscape.org/Cytoscape_3
/UserManual 

 Tutorials Streamlined 
productivity 

All users http://opentutorials.cgl.ucsf.edu/inde
x.php/Portal:Cytoscape3 

 Presentation Slides 
on Web Site 

Enable casual 
learning 

All users https://speakerdeck.com/cytoscape 

 Code Snippets Commonly used 
App development 
code 

App 
Developers 

http://wiki.cytoscape.org/Cytoscape_3
/AppDeveloper/Cytoscape_3_App_Co
okbook 

  

mailto:cytoscape-helpdesk@googlegroups.com
mailto:cytoscape-helpdesk@googlegroups.com
http://wiki.cytoscape.org/Cytoscape_3/UserManual
http://wiki.cytoscape.org/Cytoscape_3/UserManual
http://wiki.cytoscape.org/Cytoscape_3/UserManual
http://wiki.cytoscape.org/Cytoscape_3/UserManual


10. Future Plans Table 
Feature Purpose Beneficiary Timeframe 

Movies Clear and interactive 
engagement 

New/Casual users TBD 

Additional Visualizations   TBD 

Additional Analytics   TBD 

Wallpaper Collection Publicize good results 
associated with 
Cytoscape 

All users, potential 
users, general public 

TBD 

Searchable Web Site Fast access to manuals, 
tutorials, group 
transcripts, clinic 
transcripts 

All users TBD 

Case Studies Streamlined 
productivity 

New/Casual Users TBD 

Cytoscape Clinics 
 New/Casual User 
 Power User 
 App Developer 

Chat rooms give instant 
response based on 
community availability 

All users TBD 

 

Cytoscape v3.1 is the first feature-intensive release after the major refactoring represented by v3.0. We 

expect minor features and bug fixes to be released in v3.1.1, and we are planning another major feature 

release in v3.2. Though there is no time table yet for either. 

  



11. Issues Addressed 
The following issues were addressed in v3.1. Details for each issue can be found at Cytoscape’s RedMine 

issue repository: 

http://code.cytoscape.org/redmine 

Issue Description Beneficiary 

766 Need to think about "Tools" menu item.  Likely confusion between 
Tools and Apps 

All Users 

1087 New edge drawn incorrectly if you zoom while placing edge All Users 

1251 Checking to save session before closing and opening another 
session 

All Users 

1383 Need more realistic tests for Session Integration Test All Users 

1419 Visual Style is not refreshing All Users 

1448 Toggling "Show All" under VizMapper -> Visual Mapping Browser 
causes z-order to change 

All Users 

1516 Newly-installed version of Cytoscape using old cached bundles All Users 

1524 Nested Network renderer doesn't compute bounds properly Power Users 

1540 Node disappears after adding its own network as a nested one Power Users 

1644 Handling of app dependencies in the App Manager Developers 

1645 Need way to specify order for Tunables Developers 

1700 Exported .cytable files can't be imported into a different session 
due to use of SUID as primary key 

All Users 

1707 Annotation selection not working right All Users 

1767 Need API to allow apps to clean up after being uninstalled Developers 

1795 VizMapper does not refresh after visual styles are applied All Users 

1796 Visual mappings not applied to view as attributes are specified in 
table view 

All Users 

1802 cannot save All Users 

1844 New table Merge Tool Power Users 

1846 IOException "resetting to invalid mark" when trying to find a 
CyNetworkReader for a FileInputStream 

Developers 

1867 App Manager does not retry accessing App Store if first connection 
failed 

All Users 

1869 Unloading a bundle that registers a layout doesn't unregister 
layouts 

Developers 

1872 Layout settings dialog does not respond to newly loaded layouts All Users 

1873 Export-->Network Menus are disabled if network view does not 
exist  

All Users 

http://code.cytoscape.org/redmine


1895 Cancel does not work for Session Loader All Users 

1898 Prompt to continue opening session appears *after* expanding .cys 
file 

All Users 

1902 Cleanup dependency version numbers in impl poms  Developers 

1906 Update sample POM files to reflect release API Developers 

1908 Tunable dialog lost title if the params "ForceSetDirectly=true" is set  All Users 

1909 NetworkAnalyzer UI doesn't fit in Results CytoPanel All Users 

1918 Samples are useless until we rename those New Users 

1919 Launching Cytoscape via scripts on Mac doesn't initialize menu 
properly 

All Users 

1928 Create new filter API and UI Developers 

1930 unable to scale nodes All Users 

1935 Filtering unusably slow with large networks (500K+ nodes/edges) Power Users 

1944 Select -> Nodes -> File ID list File,  does not work Power Users 

1957 importing scientific notation values All Users 

1964 Edge color does not map All Users 

1968 Mac Pan/Add edge handle All Users 

1969 Feature: revamp the vizmapper GUI All Users 

1970 Pointless menu item All Users 

1977 Tool panel blocks Vizmapper All Users 

1983 Phantom node/edge selection while panning All Users 

1984 Panning de-selects nodes All Users 

1986 Installing apps via command line arguments (-b or -p) doesn't 
work... 

Power Users 

1998 Icon suggestion - Table settings All Users 

2008 Loading network from file All Users 

2009 MapTableToNetworkTablesTask should provide a way to map to 
columns other than SHARED_NAME 

Developers 

2011 Importing files All Users 

2016 getJMenu in CySwingApplication blindly appends gravity value to 
menu string, creates new menus if they don't exist 

Developers 

2022 cannot be saved All Users 

2026 Backport #2002 All Users 

2027 Cannot load network in 3.0.1 All Users 

2029 [VizMapper] ClassCastException when editing Discrete Mapping for 
visual property "Node Label" 

All Users 

2030 Edge label font size All Users 

2032 -h option doesn't properly display help screen All Users 

2034 Search should have an option to not be case sensitive All Users 

2036 Bugs in Group/Ungroup, collapse/expand, hide/unhide All Users 



2041 Tasks returned by createTaskIterator(File) in 
LoadTableFileTaskFactory abort with NPE 

Developers 

2044 edge font size All Users 

2047 NPE when setting Continuous Mapping to Node/Edge Label if 
current Network View is null 

All Users 

2051 Add a column when a local column already exists throws an 
exception, but getColumn does not see the local column 

Developers 

2052 [VizMapper] Discrete Mapping values set to wrong attribute All Users 

2054 Edge Label Transparency and Size (VizMapper) All Users 

2060 Typing error in LinkOut class Developers 

2063 Command line error loading table Power Users 

2068 Default node/edge labels do not work All Users 

2072 Update Karaf to 2.2.11 Developers 

2079 [VizMapper] Ugly descriptions on discrete mapping's font chooser 
and editor is slow to open 

All Users 

2080 extend network error All Users 

2087 Edit -> Remove Duplicated Edges doesn't trigger screen update All Users 

2088 Gradient editor min/max change automatically All Users 

2089 App bundles that fail to load still show as installed Developers 

2090 Saving Continuous Mapping Values All Users 

2091 Installation problem All Users 

2092 Open/Save dialog boxes in Cytoscape lag on Mac Java 7 All Users 

2093 Tunable ListMultipleSelection causes NPE if empty Developers 

2095 Network Merge All Users 

2096 Tunable changes have broken Layout Settings All Users 

2098 Font Face icons incorrectly aligned on Continuous-to-Discrete 
Mapping Editor 

All Users 

2099 "Undo: Hide Selected Nodes" does not work All Users 

2102 Vizmapper refresh All Users 

2109 ExportNetworkViewTaskFactory always uses SIF format when called 
with File, regardless of file extension 

All Users 

2112 Bad image export settings All Users 

2114 Bad csv table import settings All Users 

2119 installation warning All Users 

2121 XGMML: Wrong type on attribute All Users 

2126 BioPAX reader features/fixes All Users 

2137 Add SessionAboutToBeLoadedEvent as a CyEvent Developers 

2140 Update SynchronousTaskManager Javadoc to clarify function... Developers 

2141 Race condition at DestroyNetworkTask All Users 



2142 Acceptable values for ServiceProperties.PREFERRED_ACTION not 
documented 

Developers 

2144 Virtual columns are firing incorrect set events All Users 

2145 When new attributes are loaded, VizMapper does not refresh All Users 

2150 Visual Styles are completely lost when opening 2.x session All Users 

2155 inaccessible buttons All Users 

2157 Enhancement Request: API Access to Java Network View Area  & 
JInternalFrames 

Developers 

2158 Enhancement Request: Add API For Choosing Control Panel Tab  Developers 

2162 CyApplicationConfiguration.getAppConfigurationDirectoryLocation(
) Doesn't Work for Simple Apps 

Developers 

2165 Destroyed network view not removed immediately by 
NetworkViewManager 

Developers 

2166 The -v and --version command-line options cause invoke Karaf and 
cause Cytoscape to be run unnecessarily 

Power Users 

2169 bug in searching node name  All Users 

2172 Need Cy3 Repalcement for DingNetworkView.setGraphLOD() Developers 

2175 Need a way to enable REST from GUI Power Users 

2176 Need a way to select nodes based on selected rows Power Users 

2178 Node sorting by numbers All Users 

2180 cytoscape.sh syntax error All Users 

2182 Table browser context menu needs to be changed All Users 

2184 Ping Chianti for news on welcome screen All Users 

2186 Need to be able to quit Cytoscape without asking the user if they 
want to save the session 

All Users 

2190 Visual Style Discrete Edge Mappings Using EDGE_PAINT Don't Work All Users 

2191 Malfunctioning Edge paint All Users 

2195 Fix bug reporting on Mac All Users 

2197 "Grid Layout" task monitor is passed to a reader Developers 

2199 Right-click/Ctrl-click brings up context menu when zooming... All Users 

2202 Vizmapper: Color scheme reverts back to the default if NaN values All Users 

2206 Exception when changing layout parameters and executing the 
layout from settings dialog 

All Users 

2216 PSICQUIC Client creates less edges than actual number of records All Users 

2218 Need an event to notify when all apps successfully started Developers 



2221 Fix small PSICQUIC GUI Problems Power Users 

2222 Optimize PSICQUIC "get interactome" query Power Users 

2223 Fix Cancel function for PSICQUIC Client All Users 

2224 [Table Browser] ArrayIndexOutOfBoundsException after clicking the 
Function Builder button with no selected rows 

All Users 

2226 Fix cancel function for PSICQUIC Search All Users 

2227 File->Import->Ontology and Annotation does nothing All Users 

2235 Cy3 hangs during "Indexing Network Data" task All Users 

2236 [Table Browser] Popup menu shown when "Change Table Mode" 
button is disabled 

All Users 

2245 Improve organic network interface All Users 

2247 Changes to one edge bend apply to all in network with edge bend 
visual mapping 

All Users 

2250 PSICQUIC Expand Node feature should use new importer, not the 
MiCluster one 

Power Users 

2251 Legend labels are not alphabetically ordered All Users 

2257 [Table Browser] Selecting rows through the keyboard do not change 
node/edge selection 

All Users 

2259 Update Preset Visual Style for 3.1 All Users 

2261 [Table Browser] Control-click deselects other selected rows on Mac All Users 

2262 VizMapper should treat NAN as empty value All Users 

2267 Cannot Unlock Node Width/Height All Users 

2268 Layout->Clear Edge Bends doesn't do anything All Users 

2269 Missing test cases for Cytoscpae.js exporter Power Users 

2271 Provide more useful message for cancellation in PSICQUIC Client Power Users 

2272 Keep data source selection as a part of core property (for PSICQUIC) Developers 

2273 Race condition when columns deleted while BrowserTable is 
updating 

All Users 

2274 NetworkAnalyzer Help Does Not Point to Valid URLs All Users 

2279 New task monitor displays last task's message indefinitely All Users 

2280 Importing a Table from File Should Act  All Users 

2281 LoadTableFileTaskFactory no longer merges table in 3.1 Power Users 

2282 Merge data access rest service to rest-impl Developers 

2283 Importing a broken BioPAX does not provide correct user feedback All Users 

2285 Map Uniprot ID (or NCBI Gene ID)  as String Column for PSICQUIC Power Users 

2286 Equations are not saved in the session Power Users 



2287 Trying to bend an individual edge results in all edges being bent. All Users 

2292 Change Table Mode button does not make sense for Network Table All Users 

2293 GenericReaderManager.getReader() / 
CopyInputStream.copyKBytes() IOException & Incorrect Reader 
Returned 

Developers 

2294 Race condition ends in deadlock when deleting network All Users 

2296 CyActions/TaskFactories without specified gravity appear on menu 
in indeterminate order 

All Users 

2298 Use scientific species name for buttons on Welcome Screen All Users 

2300 "Import Table from URL" examples aren't valid table files New Users 

2303 Equation cannot be restored from session file if it belongs to a 
shared table but references a local table's column 

Power Users 

2309 Splash screen overlays Windows Security Alert dialog All Users 

2310 JSON Exporter does not export edge color Power Users 

2311 JSON Exporter does not export edge arrow shape and color Power Users 

2312 Replace spaces in column name when exporting to Cytoscape.js 
Visual Style  

Power Users 

2313 Locked Visual Properties are not properly handled in Cytoscape.js 
exporter 

Power Users 

2314 filter-api needs to be locked down Developers 

2315 filter-api needs Javadoc Developers 

2316 Filters chapter in manual needs to be rewritten All Users 

2317 Clear Edge Bends Menu Sets Everything to Default Even When 
Default Has Bends 

All Users 

2318 After Clearing Edge Bends, Network Is No Longer Responsive to 
Changes to the Default 

All Users 

2319 Changes to the default edge bend do not have an effect after 
Layout->Bundle Edges->All Edges and Nodes is called 

All Users 

2320 UI still refers to "Visual Style", instead of just "Style" All Users 

2324 Decrease number of iterations for Edge Bundling Power Users 

2327 Size Visual Property does not work for Continuous Mapping All Users 

2329 Need to rework the View menu  All Users 

2330 Update VizMapper GUI whenever new Bypass is created or when 
the default is cleared. 

All Users 

2331 When all edges are cleared, the default displayed in the VizMapper 
ought to display properly. 

All Users 

2335 JSON is the default format for Style export Power Users 



2336 When node width and height are locked, mappings does not work All Users 

2337 Add user/developer document for JSON exporter Power Users 

2338 Network Table should be exported as a part of JSON file. Power Users 

2339 The clear all edge bends menu item does not eliminate mappings. All Users 

2340 Clear All Edges From This Bend No Longer Working All Users 

2342 "Create View" menu item appears twice on Edit menu since 
Commands implementation 

All Users 

2343 News section of Welcome screen has light background on Linux All Users 

2344 export fails All Users 

2350 Remove D3.js JSON exporter code and create external App  Power Users 

2353 Network View as Graphics... It is difficult to put dots in filenames All Users 

2358 Filters: Deactivating then reactivating "Apply automatically" 
checkbox prevents filter from being applied 

All Users 

2359 Deprecate some vizmap-gui-api interfaces and methods Developers 

2362 Command "command run commands" is unnecessarily redundant Power Users 

2363 File->Run doesn't work properly All Users 

2365 Deadlock in CyApplicationManager All Users 

2366 Cannot move node after clearing edge bends All Users 

2367 Remove unnecessary PSICQUIC columns Power Users 

2369 Edge bend editor overwrites current mappings if canceled All Users 

2370 Nightly builds failing regularly due to Sonar failure Developers 

2371 Bugs with task status bar clearing All Users 

2376 Custom value editor broken Power Users 

2379 Welcome Screen's news section should not use JLabel, use Editor 
Pane.  

All Users 

2384 BioPAX reader is not detected when importing a biopax network 
from URL 

All Users 

2386 Some options in Merge Tables shouldn't be available in some cases Power Users 

2387 BasicCyFileFilter: extensionsMatch(uri) and getExtension(name) 
bugs 

All Users 

2392 network import file command only imports networks from tables Power Users 

2395 REST server should return 4xx series status code for errors Power Users 

2397 Cannot get list of edges from REST Power Users 

2401 CSV table/network import doesn't parse quotes All Users 



2402 rest-impl doesn't load due to missing package 
org.cytoscape.rest.RESTResource 

Developers 

2403 AnnotationManager was never exposed Developers 

2405 Fit Label Width feature does not work in 3.1 All Users 

2407 Reader manager returns wrong reader for URL import All Users 

2408 Tools menu order different from Cytoscape 3.0.x All Users 

2414 Ontology and Annotations not working again. Seems to be related 
to table import... 

All Users 

2423 CSV replaces commas with newlines All Users 

2424 File exported to incorrect location and incorrect name All Users 

2430 Update documentation for annotation-api to reflect correct 
package 

Developers 

2433 Need to replace fragile getExtension() methods Developers 

2435 Cannot read PSIMI XML v2.5.4 All Users 

2441 tableimport failed to create a tmp file All Users 

2442 Loading large network from .cys file results in deadlock Power Users 

2444 BioPAX: ID_UNIPROT column displays not a primary ID All Users 

2445 File->Export->Table... is always disabled. All Users 

2450 Network Merge throws NPE when user specify List column as merge 
key 

Power Users 

2455 Some of the Link Out URLs are broken Developers 

2461 Cancel takes forever in Network Merge  All Users 

2463 Reinstating modal task manager Developers 

2466 Clearing visual properties in DGraphView's setViewDefault degrades 
performance 

All Users 

2467 Need NCBI Gene Column for BioGRID Data Import All Users 

2469 Edge Color (unselected) All Users 

2471 Copy Style feature does only a shallow copy All Users 

2476 VisualStyle.apply(CyRow,View) is broken Developers 

2481 Undo Delete Nodes/Edges does not restore bypass values All Users 

2484 Key column drop down list does not update when changing table 
import type 

Power Users 

2485 Sample attribute data files should be renamed with proper 
extension 

New Users 

2486 Hang on MacOS 10.8.5 when opening a network All Users 

2488 Filters don't work on networks without a view Power Users 

2491 Selected network not set properly when sessions reload All Users 

2495 Add JSON format version number to exported JSON files (for 
cytoscape.js)  

Power Users 

2509 Off-by-one error during filter serialization Power Users 

2511 Mappings sometimes not applied when restoring session All Users 

 


